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1 INTRODUCTION 

Program provided facilities 

The Access Control program was designed to work with Cardax system made by ROEL company. By 
means of this program, you can monitor and program Cardax system, both operations being real-time 
performed. The user gets an overview upon Cardax system status and the occurring events. So, there is a 
message log (filters can be applied to it), a status window (for door status, communication status, etc.), 
and a window for the objective map as well. System programming is extremely easy and is done by means 
of easy to use intuitive windows. As for reports, the program provides a report generator with several 
options for report generation in HTML format - easy to use by the Microsoft Office programs. Events 
occurred from Cardax system can be also saved in DBF format in order to be lately processed by any 
database program recognizing this program (actually, all programs do). For the operation systems not 
offering a high security level (Windows 95/98/SE/ME), the program uses a basic method for data 
encrypting, any modification being detected. However, in cases total security is needed, Windows 2000 
system is recommended. The program also offers access levels (network administrator and usual user) in 
order to prevent Cardax system wrong programming by usual users. The program interface is simple and it 
is part of the standard applications designed for Windows platform. 

System requirements 

•  Operation system: Windows 98, Windows 98 Second Edition, Windows ME, Windows 2000. The 
program also runs on Windows 95 with the Internet Explorer 4.0 SP1 update (or with the 
common controls library).  

•  Processor: according to the operation system, minimum 233Mhz, 400Mhz recommended (in case 
the program does not run by itself, a stronger processor is recommended for the communication to 
work on best parameters)  

•  Memory: the memory necessary for the operation system to run plus 8Mb for the program. For 
example, for Windows 2000 you need 8 free Mb memories except the 64Mb necessary to the 
operation system.  

•  Disk space: 1Mb necessary upon first installation. In time, due to the real time feature of Cardax 
system and to several stored events, you should keep a free space of up to a few hundreds of Mb. 
For example, a 1000-card system, each of them producing only 10 messages a day, would 
generate at least 200000 messages a month, without considering other types of messages. Thus, 
the necessary space for 200000 messages is of about 30Mb.  

•  Resolution: minimum 800x600. The resolution the program was designed for is 1024x768. 
Obviously, higher resolutions are welcome.  

Possible problems 

The software was tested on the above-mentioned platforms. Due to the fact that the above mentioned 
operation systems are error-prone environments, there can be disfunctions to affect the soft. In order to 
improve this program, the user should report any strange behavior to ROEL company for the possible 
trouble to be solved as fast as possible. Not to receive erroneous reports (generated by the 
misunderstanding of program functioning), the user should read the documentation on Cardax system and 
the user's manual. 
 

INSTALLATION 

Run Setup.exe program from installation kit and follow the instructions. After install, at the first program 
execution, the user will be asked for the installation key: 
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Figure 1.1 Installation key dialog 

The key code may be obtained from ROEL company. The company will need the displayed code and will 
answer with a code for your software copy. The code given to you will is based on the code displayed and 
it is valid for your computer hardware. If you need to reinstall the program on other computer or harddisk 
you will need another code.  

If the code is properly entered you’ll be asked for a user name and a password. 
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Figure 1.2 Login start dialog 

The default user is Admin and default password id access. This account has administrator privileges for 
the software (has programming rights for Cardax system). It’s a good practice to change this account after 
the first start.  

In case you entered a wrong installation code or if you pressed Cancel button, then the following message 
will appear: 

Cancel 

 

Figure 1.3 Wrong installation key message box 

The program will close. You will have to repeat the installation code procedure at the next run. 
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2 MAIN WINDOW DESCRIPTION  
 
The main elements and functions of the access control software will be presented in this chapter. 

2.1 Main Menu and Toolbar 

 

Figure 2.1 Main menu 

File Menu 

 

Figure 2.2 File menu 

Login – The option changes the current user 
Save Database  - save  the system configuration on harddisk and generates backup files automatically. 
Also, it converts the access control system database files to DBF format.    
Extract log – concatenates event daily files in a specified period or extracts some events from another file. 
The events will be stored in another file, in which events will be sorted ascendently, by the date they 
appeared. 
Assemble log – concatenates extracted event files sorting events by date. 
Convert log to DBF – converts event log file in DBF format. The file obtained may be imported in Excel or 
access or FoxPro, in order to obtain user specific reports. 
Exit – exits application and saves database files. 
 

ACCU Menu 

 

Figure 2.3 ACCU Menu 

At the first run, the options Erase Cards and Erase Events should be used. The central unit will be erased 
and ready to keep a fresh database. Make sure the JP2 jumper of the central unit board in closed to 
battery backup the memory and real time clock. 
RIMs – launch the periferic module configuration dialog box 
Door Names  – launch the dialog box for editing access point names. As default, the door names are 
taken from the building map displayed in the main window.  
Schedules – launch schedules dialog box 
Zones – launch zone (access levels) schedules dialog box 
. 
Cards – launch code configuration dialog box. The codes cannot be programmed manually. They would rather 
be taken from the readers with a specific procedure described in this manual. 
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2.1.1 Report Menu 

 

Figure 2.4 Report Menu 

Event Report Generation – launch a dialog box containing reporting filters. From this dialog, reports are 
generated, based on access events.  

ACCU events in period – Any event type, UCCA and Access source, period filter activated. 

Card event in period – Any event type, Access source, period filter activated. 

Last 1000 events – Any event type, any source, max. 1000 events 

Last 1000 error events – Only error event type, any source, max. 1000 events 

List of RIMs, doors, schedules, zones, cards, expired cards – These options generate HTML 
reports with the system configuration. 

Person present in the building – Using this option the user could check whenever a person is in the 
building by searching the events produced, with the person's card.  

Presence list – This report shows a list of people present in the building at the time the report is 
generated 

Options Menu 

 

Figure 2.5 Option Menu 

Configuration – launch a dialog box with software working parameters 
Passwords – administrates software user accounts (dispatchers) 
History – This option is accessible only root user and is used for debug purposes. 

Help Menu 

 

Figure 2.6 Help Menu 
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User Manual – launch the programming manual, in HTML format, in an instance of your computer’s 
Internet browser.  
About - displays a message containing minimal software information 

2.2 The Toolbar 

 

Figure 2.7 The Toolbar 

The first button group: 
Save database: (Ctrl+S). Menu option File->Save database 
Extract log: Menu option File->Extract log…  
Assemble log: Menu option File->Assembly log  
Convert log in DBF: Menu option File->Convert log in DBF  
 
Second group 
RIM-s: Ctrl+R. Programming menu->RIMs … 
Door Names: Ctrl+U. Programming menu->Door Names … 
Schedules: Ctrl+O. Programming menu->Schedules … 
Zones: Ctrl+Z. Programming menu->Zones … 
Cards: Ctrl+C. Programming menu->Cards … 
 
Third group 
Report generation: F2  
 
Fourth group 
Software configuration: F5.  
Accounts: F6.   
 
Fifth group 
Help: F1.  
 

2.3 System status window  

 

Figure 2.8 System status window 

 

The following information is displayed: 

- Communication ACCU – PC status on the first line 
- The ACCU hour and PC hour  
- Event number in ACCU – the number of events left in the central unit since the last transfer  
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- Cards in ACCU 
- Number of modules the central unit communicates with (max. 32). The squares have the 

following significance: 
o Gray square: communication with the module is OFF 
o Black square: communication ON , door open 
o White square: communication ON , door closed 

 

2.4 Building Map Window 

 

Figure 2.9 Building map window 

The window displays a schematic map of the supervised area. The map has the above configuration as default,  
but this may be changed by means of map editor software delivered in the same package. There are 
three object types in the map: 

Polygons which separates surveillance areas 
Doors – access points in the area 
Texts for additional information 

 
The door areas will be colored distinctly, depending on the events occurred at the correspondent access 
points. The colors are: 

Grey if the door is closed; 
Green if the door is opened following a valid access. 
Red if the door is forced, the code is not valid or the communication is OFF 
Yellow if the door is propped following a valid access. 
Blue if the access is not performed and the door may be released for an unauthorized access  

The map may be zoomed by means of Zoom controls on the left bar of the map area window. 
 

2.5 Message Window  

This windows displays various messages received from the access control system. The messages shown 
may be filtered by changing options from the configuration menu. There are several view types, depending on the 
amount of displayed information and the message source:  
- All messages: displays all messages: access, from the central unit and from software   
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Figure 2.10 Message window – All messages 

- ACCU Messages: Displays all events received from ACCU (valid accesses, door propped, forced, opened, 
etc.) 

 

Figure 2.11 Message window – ACCU messages 

- System messages: displays messages generated by software 

 

Figure 2.12 Message window – System messages 

- Access messages: displays only entries, exits and access button commands 

 

Figure 2.13 Message window – Access messages 
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 Presence Messages: displays only access messages from presence access points 

 

Figure 2.14 Message window – Presence messages 
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3 USING THE SOFTWARE 

Each time the program is started, it will demand a login name and password. 

This information is given by the installer or system administrator. There are three privilege levels. The most 
privileged is the Root user, which has debugging rights. Only ROEL technical department have passwords 
for this user. The next privileged user is Admin and has programming rights. The other accounts have only 
monitoring privileges and also they may generate reports. Any user may change his/her password and also may 
modify accounts with lower privilege levels. 

One step further is to establish communication with ACCU. This is done in Options Menu - Setup 
where the proper serial communication port is chosen and other parameters can be set. If ACCU is 
detected on the chosen serial port, the status window should display communication presence. If this does not 
happen, the user should check the cables, the serial port availability, the proper initialization of the serial 
port (the program issues a warning if the port doesn't initialize) and the ACCU power supply. Once 
detected, it is possible for ACCU to transfer dirty events (only on the first start). In this case, the user 
should erase the event log memory together with the card memory. Settings should be selected). 
The main window is shown below: 

 

Figure 3.1 Main window of access control software 

The system may be monitored and reports may be generated by any user of the program. It is possible to 
watch:  

- System events in Message window 
- System status in the left area of the screen 
- Access point status in the right area of the screen 

The system may be configured only by users with root and admin privileges. They may configure: 
- Other user accounts 
- Program configuration 
- system database (zones, schedules, cards, etc.) 
- peripheral modules 
- ACCU database 
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4 OPTION MENU  

Program Configuration  

 

Figure 4.1 Configuration dialog box 

Programming parameters can be programmed by using this window. 

Different parameters are grouped in five categories: ACCU Parameters, Colors, Message Filter, Map settings 
and Database 

4.1.1 ACCU Parameters section  
 

 

Figure 4.2 ACCU Parameter section 

Serial port 
Choose one of the four options from the combo box. The port should control an external connector and 
should not be used by another equipment (mouse, modem, etc.) The communication port refers to the serial 
port the central unit (UCCA) is connected to. This port must be properly programmed and should not be 
used by a different device. When changing the communication port without leaving the program, the result 
of the initialization is displayed in the message window 
Detection message sending interval is measured in tenth of a second, being the time interval at 
which requests of UCCA detection are sent on the serial port before initializing the communication to the 
port. Value 10 (one second) assures the detection of UCCA in maximum one second since its connection to 
the serial port.  
Values allowed are within range 1 – 100 seconds. 
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Status message sending interval is the interval (in tenths of a second) at which UCCA status is 
interrogated about as soon as communication was set. The default value (0.4 seconds) offers a good 
synchronization under normal working conditions.  
The program sends permanently to ACCU two requests: event request and status request. Values allowed 
are in range 1 – 100 tenths of a second. 
The maximum time difference is the difference in seconds allowed between the UCCA clock and the PC 
clock. Under normal functioning conditions, a 5 minute difference is acceptable. The minimum difference is 
of 2 seconds, due to the interrogation, transmission/receiving and processing time. The moment that the 
time received from UCCA is shifted more than this number of seconds, a date and time setting message will 
be sent. 
Retries in case of... is the number of times the application tries to retransmit after errors of a certain 
type. These parameters can be left as default. After the programmed number of trials is completed, a 
warning message will appear in message window. 
Timeout 
Defines the number of trials of the current message to send to the central unit if it doesn’t respond more than the 
default timeout (3 seconds). This may occur when the central unit is busy to delete the memory or to 
sort user codes, or when the communication with the unit is interrupted.  
Desynchronisation  
Defines the number of trials of the current message to send to central unit when a desynchronization appeared 
between the central unit answer and software desynchronization request.  
Comm Error  
Defines the number of trials of the current message to send to central unit when incorrect messages are 
received.  

4.1.2 Color Section 

 

Figure 4.3 Color section 

Colors section refers to colors associated to different kind of messages showing up in the message 
window. By pressing button B, the background color of the left-side message can be changed, while 
pressing F, text color can be changed. 

 

Figure 4.4 Color Dialog Box 
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4.1.3 Message filter section 

 

Figure 4.5 Message filter section 

The message filter is just an aesthetic facility. The moment that certain messages are selected to be 
hidden, they will keep showing up in logs, without appearing in the message window. System refers to 
messages generated by the application (confirmations, errors, warnings, etc.), while ACCU refers to 
messages received from UCCA, actually.  

Map settings section 

 

Figure 4.6 Map settings section 

The parameters of the building map are two in number, being the file containing the map and the option 
of taking door denominations from the map upon loading. That can be necessary when the map was drawn 
in the editor and door denominations have already been written there. One of the cases when taking 
denominations is not desired would be when denominations have already been modified in Access Control, 
and loading a new map is to be performed keeping these denominations.  

4.1.4 Database section 
 

 

Figure 4.7 Database section 

The last option is quite important, allowing or not card entering from readers. This option is recommended 
to be disabled after all cards were entered, so that a possible Intruder message does not cause an 
accidental card entering the database.  
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Passwords  

This option opens the software account dialog window: 

 
Figure 4.8 Accounts dialog box 

By means of this window, program user's accounts can be managed. This window is only available to the 
administrator. All accounts appear in the list, the first one being the administrator's. He/she can have a 
different admin name (he/she can change names), being the only one having these rights. At will, the 
administrator can add or delete accounts or modify information regarding an account. Normally, when the 
administrator or a usual user tries to change his/her own password, he/she must first enter the old 
password. That is useful when the administrator is changing the other user information. 

 

Figure 4.9 Adding/Modifying account 

 

Figure 4.10 Deleting account 

When the usual user accesses option Passwords, user data modifying window will show up instead of this 
window. The usual user may not change the name but the password. In case the user leaves the new 
password empty, he/she will be notified to do it as a security mean. The maximum number of users is 31, the 
password can have at most 15 characters, and the name at most 30. Important! When passwords are 
entered, differentiate between capital and small letters. 

History 

This option displays a report containing all software operations in a time period. The report is accessible 
only for the root user, for debugging purposes. To the other users the option is disabled. 
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5 SYSTEM PROGRAMMING 

All central unit (UCCA) modifications, card sending, peripheral modules, zone and time table programming 
(RIM) are operated in this menu. The order of the first set of options in this menu is not accidental, but the 
natural order a Cardax system is set up for the first time. 

Windows showing up as a result of enabling the options in this menu have certain common features. In 
windows where buttons OK and Cancel appear, modification inside the window will be saved only if OK is 
pressed. In case the keypad is used, key Enter is similar to OK button, while key Esc is similar to button 
Cancel and to the button which closes the window. In case Cancel is pressed, any modifications inside 
the window will not be saved. A special case is a RIM, zone or timetable modification, which is sent to the 
UCCA. At that moment information has not been saved yet in the databases as OK has not been pressed in 
the RIM, zone or timetable window. So, in order to avoid a loss of synchronization between the 
programming in UCCA and databases in the PC, the user is asked to confirm, saving in databases the RIMs, 
zones or timetables to be sent. In this case, even if Cancel is pressed, RIMs, zones or timetables, which 
were sent, will have already been modified. This behavior prevents a loss of synchronization, which later 
can cause confusions. Obviously, RIMs, zones or timetables to be sent may not be changed. Thus, button 
Cancel works as before. Important! Saving in the databases means bringing up-to-date the 
database in the PC memory. In order to get the last modifications on disk, option Save 
database in File Menu is recommended to be used. 

Another common element of these windows is element selection in order to perform certain operations. 
An element in a list is selected if its corresponding checkbox is marked. When an element is being 
modified (meaning modifications are saved by pressing key OK , the element will be selected to remind the 
user it should be sent to UCCA (for a loss of synchronization not to appear). In case a multiple selection is 
wanted, buttons All, None and Reverse can be used. Button All selects all elements, irrespective of their 
previous status, None deselects all elements, and Reverse inverts each element selection (if it is selected, 
the button will deselect it, and the other way round). Selection is used to mark elements to be sent to 
UCCA upon pressing button Send, or in window Cards when cards are to be deleted. 

In case these windows are to be worked with faster, the following key combinations must be known: 

•  in lists (for RIMs, zones, timetables, doors and cards) the arrows (up and down as well as keys 
PgUp and PgDown (for placing on the respective element) can be used  

•  combination Alt-Enter is equivalent to a double-click on an element in a list or to pressing button 
Modify. Combination Alt-M can be also used  

•  in order to select/deselect an element in a list, key Space can be used after placing on the 
respective element  

•  generally, to press a button faster without using the mouse, combination Alt+Letter can be used, 
where Letter is the letter underlined in the button text.  

Last mention: only the user with administrator privileges is allowed to program the system; the ordinary 
users is only able to visualize them. 
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RIMs 

 

Figure 5.1 Rims dialog box 

From RIM-s dialog the administrator may program the parameters of the periferic modules of the access 
control system. At the first start of the program all RIMs have the same default parameters. At any time all 
32 RIMs are available to be configured even if the system runs with less modules. After programming the 
RIMs, parameters should be send to ACCU. Each active RIM should confirm the parameters by an 
acknowledge message (Rxx Parameters set ). Together with the acknowledge message, the door sensor 
status of the RIM is displayed in the status window.  

 

Figure 5.2 RIM configuration parameters 

To program parameters for a RIM you have to double-click the RIM or select the RIM, and press Modify 
button. For one RIM there are the following parameters:  

•  The Reader card type (magnetic stripe, proximity 26 bits, proximity 34 bits or keypad code).  
•  The access point (door) at which the RIM module is mounted.  
•  The lock device relay time (in seconds).  
•  The access time (in seconds) - the necessary time for a person to pass through the door and close 

the door behind.  
•  Antipassback options  
•  IN/OUT sense. A software way to invert the IN/OUT access messages.  
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•  Time attendance RIM. This RIM will generate events that will be processed by the Time and 
Attendance program.  

 

Figure 5.3 Rims copy dialog 

To simplify RIMs settings, the Copy option could be useful. By means of this option the parameters for 
one RIM are copied on another. This action saves time when more RIMs have the same parameters. However,
the proper door should be configured for each RIM .  

Door names 

 

Figure 5.4 Door Names dialog box 

For the Access Control system the RIMs and the access points are distinct terms. The doors are used to 
define the access areas (zones) and to reflect the building configuration. For this reason the door 
names could be changed and could be seen on the building map window. In this dialog the door names 
may be changed. The names are saved in the system database and are automatically updated in the map 
and in the RIMs parameters. When a new map is loaded, the user has the option to keep door name or to 
import map door names. 
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Schedules 

 

Figure 5.5 Schedules dialog box 

The system provides 20 schedules. A schedule is a week timetable for a card access. A card has as 
parameter one of the schedules identifier. By default the schedules are configured to allow access to the 
cards at any time. 

 

Figure 5.6 Schedule configuration dialog 

To configure a schedule, the user has to double-click the schedule or to select the schedule and press 
Modify button. The schedule contains the time table for a week (Monday to Sunday) and contains also a 
timetable for a special day (holiday). The days are split in 48 slices of half an hour. The firs half hour 
corresponds to the interval 00:00 - 00:30, the second half to the interval 00:30 - 01:00, etc. If a slice is 
selected, then  the access is granted, in the correspondent half hour.  
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Figure 5.7 Schedule filling dialog 

A mechanism to ease the completion of slices is provided by means of Complete dialog. In this 
dialog the user chooses the interval and the completion mode. 

 

Figure 5.8 Schedule copy dialog 

Like RIMs, the schedules could be copied one over another.  

 

Zones 

 

Figure 5.9 Zones dialog box 
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The zones are door groups implementing the restricted area feature in the card validation process. One 
zone may contain up to 32 doors. If a door is contained in a zone, all cards that have the zone as parameter
are validated to pass through that door. One may configure up to 100 zones 

 

Figure 5.10 Zone configuration dialog 

To configure a zone the user has to double-click the zone or to select the zone and press Modify 
button. In the dialog shown up there appears a list of the 32 doors each one with a checkbox on the left as 
shown in the figure. If the checkbox is set the door is contained in the zone. To simplify configuration there 
are buttons All, None, and Reverse.  

 

Figure 5.11 Zone copy dialog 

For zones also, the Copy option is implemented.  
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Cards 

 

Figure 5.12 Cards dialog box 

Cards dialog is used to program card parameters. In this dialog there is no Cancel button. Every change 
on the cards is permanent, therefore needing more attention to be paid. On deletion, sending, erasing from 
database there will be many message boxes asking the user to confirm operation.  

 

Figure 5.13 Card parameter dialog 

To edit card parameters the user should access this dialog. The parameters are:  

•  Code: an unique 4-digit identifier for the card.  
•  Card code: is the physical code of the card and is acquired through a RIM. The card code may be 

seen only by the administrator, for an ordinary user the field meaningless characters.  
•  Name: stores the full name of the card owner.  
•  Department: stores the department's name or code where the owner is assigned.  
•  Zone is the zone identifier specifying where the card has access.  
•  Schedule is the schedule identifier specifying when the card has access.  
•  Expires specifies the date when the card is no longer valid for the system  
•  Holiday is a flag used to deactivate card access when the owner is on holiday or if there is a  

special day. When this flag is activated, the system verifies the vacation timetable of the card's 
schedule.  
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To add cards in the database, the communication in the system should function properly. There are 
two methods: card by card method and incremental method. The first method needs entering each card at a 
reader in the system while Cards dialog is open. The cards will be detected as intruders and their codes are 
automatically entered in the pop-up card configuration dialog. The operator may enter the card parameters 
in the dialog controls and save the card in the database. The second method saves time while grabbing 
card codes but works only when the cards have successive codes. In this case, the user enters the card with 
the smallest code at the RIM, and when the pop-up window appears, there will be an option to add a number 
of cards auto incrementing the codes. Once the codes were grabbed in the program, there will be time to 
configure each card with specific parameters. Important! Only the administrator is allowed to add 
cards, and only if the option "Accept new cards" is selected in Configuration dialog window.  

 

Figure 5.14 Add card popped up dialog 

Note: The code is now stored in the computer database. To make it active you have to send it to the 
central unit.  

Selection button: To choose cards to be transmitted to the central unit there are two possibilities:   

1. selecting card by card from the card dialog box (marking the front check boxes) or by pressing the 
buttons All, None, Reverse 

2. using the Selection button to select a range of consecutive cards. 

 

Figure 5.15 Selection window 

The parameters of the first and last cards in the range are displayed in the window. Upon pressing OK 
button, the cards front checkboxes will have the value specified by means of the radio buttons: selected, 
deselected, inverted. 
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Card transfer to ACCU 

There are three buttons: Send, Delete and Stop.  

Send button transfer the selected card to ACCU. The cards are sent in the ascending order of codes to 
optimize the transfer speed. The central unit confirm each card received, and the software displays the 
response in the message window. In case the central unit code memory is full, then a warning message will 
be displayed in the message window. 

Delete button deletes selected card from ACCU but not from the PC. The card codes are sent in 
descending order to optimize the transfer speed. The central unit confirms each card deleted and the 
software displays the response in the message window. In case the central unit code memory is empty, 
then a warning message will be displayed in the message window. 

Stop button interrupts transmission activity. The same thing happens when the user closes the card dialog 
box before transmission completes.  

Erase card memory 

This option allows the administrator to erase card memory in ACCU. The option is useful when the card 
memory should be empty for a new configuration.  

 

Figure 5.16 Erase card memory message box  

Erase event memory 

This option allows the administrator to erase event memory in ACCU. It is useful at the first start when 
there could be invalid events in the memory.  

 

Figure 5.17 Erase event memory message box  

Date Time set 

Although the software provides an automatic synchronization mechanism, whenever the difference 
between ACCU clock and PC clock is greater than a specific number of seconds, sometimes the date and 
time is useful to be manually updated. This option realizes the update. Important! The PC clock should 
function properly, otherwise the system may to generate erroneous messages and 
events. 
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6 REPORT GENERATION 

Event report dialog box 

 

Figure 6.1 Report generation dialog box 

In addition to the conversion of event logs to DBF files, and the use of other software to see the result, (File 
Menu), there is the possibility to visualize the logs in HTML format. The advantage is a friendly presentation 
and a good interaction with Microsoft Office software, which can easily import HTML documents. The HTML 
files are temporary files and they include an auto deletion script that activates when the browser is 
closing. To keep the files on the harddrive, there are save options in the browser menu. It is also possible to 
copy/paste the information in Excel or Word.  

The first option of the dialog window refers the log files source. The report may be obtained from daily 
logs or a previous extracted log file. It is possible to specify the type of messages to appear in the 
report. There are four checkboxes to use. In the figure, all of them are selected. Another group of filters is 
message source. The user is usually interested in access messages (IN/OUT), but there are other options 
as program generated messages or messages received from ACCU. Important! Choosing all event 
types and sources has as effect huge HTML files with many useless events, files that slow or 
block the browser. In case the selection is ACCU messages or access messages, two additional filters are 
available: The door where the message was generated, and the card that generates the event. When  
<Any door> or <Any card> are selected in the filter controls, then these filters are ignored. Another filter 
available is period filter. Important! Choosing large periods of time generates huge HTML files 
difficult to load by browsers. The last filter is "number of message", its use being to prevent loading 
problems. The filter limits the number of events displayed.  
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Generate button will instantiate a Internet browser window containing the HTML file: 

 

Figure 6.2 Report page in the Internet Explorer browser 

 

 

Figure 6.3 Security Alert Message when closing Browser window 

If this message appears when browser closing, it means the file is trying to delete itself (it is a temporary file). 
Internet Explorer browser warns that the Web page is trying to modify the disk. In this case, confirm  the 
"ActiveX Control" action. 

The following four menu options are preset for the filters described above.  

ACCU events in period 

Any event type, UCCA and Access source, period filter activated. 

Card event in period 

Any event type, Access source, period filter activated. 

Last 1000 events 
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Any event type, any source, max. 1000 events 

Last 1000 error events 

Only error event type, any source, max. 1000 events 

List of RIMs, doors, schedules, zones, cards, cards expired 

These options generate HTML reports with the system configuration. 

Person present in the building 

 

Figure 6.4 Person present dialog box 

Using this option, the user could check whenever a person is in the building by searching the events 
produced with the person's card. If the person is present, the program displays the last access point (door) 
and the time of the last access. To be considered present, a person should generate an IN event for the last 
24 hours on a RIM having "Time and attendance" parameter set. The person is absent if the last message 
of his card for the last 24 hours is an OUT on a RIM having "Time and attendance" parameter set.  

Presence list 

This report shows a list of people present in the building at the time the report is generated. 
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7 FILE MANAGEMENT 

 

In the File menu of the application, someone can work with log files of events soft-generated, the soft 
user can be changed without leaving the program, and memory databases can be synchronized with the 
ones on the disk. 

Login  

In order to use the soft in a secure way (compensating for the security lack on Windows 95/98/ME 
systems), the soft defines user accounts. There can be at most 32 accounts, standing for the identifying 
method of the soft user in order to establish user’s rights. Each account has a name and a password which 
can be selected at will. Within the program, the first account is admin account, corresponding to the 
system administrator. All operations provided by the soft can be done from this account: system 
programming, account administration and log file management. On the first start, the default account is 
admin with password access. This account is strongly recommended to be changed. In case people using 
the soft have equal rights in administrating the system, there is no use for creating accounts for each user, 
as everyone could use the administrator account. In case some users are not allowed to modify system 
programming, accounts will be created for each of them, these accounts being usual ones without allowing 
access to the system programming commands. The administrator account is unique and is not to be 
deleted. Usual users may not change their names. They can change only the password. In order to view 
the way of managing accounts and assigning passwords, see page passwords. 

 

 

Figure 7.1 Login dialog 

Option login in this menu allows user changing without leaving the program without having to restart 
the program. Upon activation, the next window will show up, where the user can enter name and 
password. In case of a successful login, the operation will be confirmed in window messages as well as in 
the title bar of the main window, where, along with the application name and version, there will also be the 
current user's name.
Important! The password must be entered as it is, without any other blanks, using capital or 
small letters. For names, there is no difference between capital or small letters, and blanks are not 
necessary, either.  

Save databases 

Within the application, the system databases consist of card information files, the RIM, zone, timetable 
configuration, the building map and the file containing program functioning parameters. Under normal 
functioning conditions, the program loads these files upon starting, and saves them upon shutting down. 
There is a disadvantage of this functioning mode as in case the program does nor shut down properly (AC 
loss, etc.) the modifications will not be saved on the disk. This option allows saving the information as soon 
as certain modifications were done. This option is recommended to be used as soon as the system was 
programmed (RIM parameters, card entering, etc.), a confirmation message showing up in messages 
window in case of a successful saving. In case an error occur during the data saving process, the user is 
asked to confirm resaving or canceling the job. The only error that could occur would be low disk space. 
The program automatically creates safety copies for the database files in a directory; BACKUP in the 
application folder. Important! Due to the unstable feature of Windows platform, saving of DATA 
directory from the application folder is recommended to be periodically performed. If data are 
unfortunately lost, they may be manually copied. Another solution would be manually copying 
files in BACKUP directory into DATA folder.  
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Extract log 

Messages received from UCCA, as well as confirmation and status messages generated by the program, 
are stored in directory LOGS, using a tree-like structure according to years, months and days. This 
structure allows an easier processing and a better reliability. Troubles concerning the huge file merging 
from the concatenation of all files in a single one are removed, and a possible corruption of the message 
files will only affect the respective days. In case space is to be freed up, a manual back-up can be 
performed, by copying or deleting the days no longer needed. Restore is simply done by copying the saved 
files. Obviously, this operation implies the understanding of log storing mechanism. 

 

Figure 7.2 Extract log dialog box 

Extract log actually refers to log creation by copying messages from different or daily logs. For 
example, the option can be used for time and attendance for a certain month. The window is activated, 
daily logs are selected as source, the period is selected, and then the message type. Access messages are 
implicitly selected, but messages of any type can be also selected according to the 3 checkboxes. Apart 
from extraction from daily logs, extraction from a different log file can be done. That can be useful in case 
there are no daily logs for the respective period, but only a log file previously extracted.  

Assemble log 

By means of option assemble log, several logs can be concatenated in a single one. That is useful in case 
messages in daily logs are no longer available, but only in certain files previously extracted. The assembling 
function combines these logs into a single file, arranging the messages chronologically. In order to select 
the files to form the new log, use keys Shift and Ctrl in the window files are selected in. 

Convert log into DBF 

In case special processing against log files are to be performed, there is a conversion option in DBF 
format. The files thus created can be opened in any application of the spreadsheet type.  

Exit  

Exit program and save database.  
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8 HELP MENU  

Help button launch the software user manual, (HTML format) in an instance of the Internet browser 
program. 

 

Figure 8.1 User Manual – HTML format 
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9 ANEXES 

Ques t i o ns  and  answe r s  

What should you do in case the soft is asking for a registration code? 

This situation occurs either on the first soft installation or on the soft reinstallation on a different 
computer. In order to start the soft, contact ROEL company in order to get the right code. 

What should you do in case the password was forgotten? 

In case you are a network administrator and you forgot your password, you must contact ROEL 
company. In case you are a usual user, just ask the system administrator to install a new password. 

What should you do if the soft does not detect UCCA? 

The first thing you should do is to check the cables and the power supply. Next, check if the serial port 
where UCCA is installed is not assigned to a different device (modem, mouse, etc.). 

How should you hide synchronization errors? 

If losses of synchronization with UCCA occur while the soft is working, the user will be warned by 
messages, which can grow in number in case of a severe multitasking. In order to hide these messages, 
the message filter can be used in the configuration window. Here, you can select the warnings from 
the system not to occur. 

How do you create DBFs with the events occurred? 

These DBFs can be either created from log files extracted from daily logs (extract logs then convert log into 
DBF) or automatically by Access Control. As events occur in the soft, it will save them within daily logs and, 
at the same time, within the two DBF files in the directories dbf, system.dbf and ucca.dbf. All soft 
generated events are stored in dbf/system.dbf, while events (the access ones included) from UCCA are 
stored in dbf/ucca.dbf. In case the files are deleted, the soft will recreate them only containing the newly 
occurred events 

F a s t  Gu ide  

Quick system programming 

After running setup program, the user should start the Access Control program. On the first start, the 
user should enter the registration key. The key could be obtained from ROEL company. After registration, 
the user is asked for a name and password to run the program. The default account is administrator with 
the name admin and password access. The account rights allow all programming operations. It is a good 
practice to change the password for this account, by selecting Passwords from Options Menu. One step 
further is to establish communication with ACCU. This is done from Options Menu - Setup where the 
proper serial communication port is chosen and other parameters could be set. If ACCU is detected on the 
chosen serial port the status window should display communication presence. If this not happens the user 
should check the cables, the serial port availability, the proper initialization of the serial port (the program 
issues a warning if the port doesn't initialize) and the ACCU power supply. Once detected, it is possible for 
ACCU to transfer dirty events (only on the first start). In this case the user should erase the event log 
memory together with the cards memory. Next step is RIM configuration from RIMs dialog. For all 
existing RIMs the user should enter the settings, send configuration to ACCU and save the new information 
on the disk. Next step is Zones and Schedules programming from Schedules and Zones dialogs. The final 
step is card programming. For each card there are validation parameters to set: the access zone, the 
access schedule, and expiring date. All card parameters are entered from cards dialog. To gather a new 
card code this dialog should be accessed and the option New cards on the dialog Settings should be 
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selected). There will take some time to pass the card configuration to ACCU. Once all programming 
finished, the system is ready to go.  

Working with event log files 

The log files store the events received from ACCU and events generated independently by the software. 
There are two log types. First type is daily logs. These logs store information at the time the events are 
issued. The daily logs are real-time updated and are stored in logs directory in a tree structured 
subdirectories with names corresponding to the year, the month and the day the log was produced. The 
software automatically stores events in DBF format in the same manner it stores daily logs. The storing 
directory for DBF daily files is dbf. The second log type is obtained by concatenation other log files. These 
logs are created by extracting the chosen type of events from the daily logs or by assembling together two 
or more log files from the same directory. The event type could be system (software generated events), 
ACCU (messages received from the central unit and access. More over, the event log files could be 
translated in DBF format using option Convert to DBF.  

Report generation 

An important function in an access control software is to generate reports. The program contains a 
report generator with many filters. The reports are obtained accessing Report Menu. The report file 
format is HTML. They are temporary files and are automatically deleted when the HTML browser window is 
closed. To transfer the reports to other programs the procedure is the following: Ctrl+A (select all), 
Ctrl+C (copy to clipboard) and then Paste in the target program. This method functions with Microsoft 
Word and Microsoft Excel (and other Office software programs). Another method is to explicitly save the 
report in HTML format for later inspection.  
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